Version 2.2 August 2004

P u C ]__ Purdue University

Cytometry Laboratories

cytometry laboratories

Introduction to WinMDI 2.8 (J. Trotter 1993-1998)
for the Analysis of

Flow Cytometry Listmode Data Files

Objectives of this tutorial:

- Open a listmode data file

- Create histograms (single, dual, and 3D histograms)
- Perform gating

- Perform original analysis

- Display statistics

Gérald GREGORI, Ph.D.

Kathy RAGHEB, M.T.(A.S.C.P.)

J. Paul ROBINSON, Ph.D.

Purdue University Cytometry Laboratories

Hansen Life Sciences Research Building, B0O50

201 S. University Street,West Lafayette, IN 47907-2064,USA
e-mail: gregori@flowcyt.cyto.purdue.edu
http://www.cyto.purdue.edu




Version 2.2 August 2004

Contents

1. HOW 0 INStall WINMDI 2.8 ...t 1
I HOW t0 Start WINIMIDI 2.8 ..ot 1
I11. How to Create a Single-parameter Histogram ...........ccoceviiininiinininnenene e 3
IV. How to Create Histogram OVErlay ...........ccccovviieii i 5
V. How to Create a Dual-parameter HiStOgram ..........cccoeveiiiinininieiene e 6
1. HOW tO Create @ dotplOt.........ooiiiiiiieieeee s 6

2. How to create a Density plot or a Contour PIOt............cccvevviieiiiii e 8

3. How to create a 3-dimensional display ..........ccccooviiiiiniiiiienie e 10

4. How to change the parameter labels and font..........ccccccovvviiieii e 11

5. How to display a title or write annotations on a graph ..........ccccceeevieiieneiieneene 11
AV B oo ] 1 o TP PP PPPPTUPPRPPPPRPPRS 12
VII. How to Create and Display Several Graphs on the Screen..........ccccccevvvevvinennn. 13
VI REGIONS AN GALES ..ottt sttt nae e 14
1. Create a region on a 1-parameter hiStogram ..........cccocereriieninienieene e 15

2. Create a region on a 2-parameter histogram..........cccovveveiieiiennsiee e 16

3. HOW tO Create @ qUAAIANT .........eieiiieie ettt 17

4. How to delete, move, or adjust @ FEQION .........ccvevveeierieereeie e 18
5. CrBALE GALES ... ittt ettt ettt ettt ettt b h bt et e e a et et e ann e b e naneenes 19
IX. Converta FCSfile to ateXt file ... 20
1. Convert adata fille ..o s 20

2. Only convert the data from a gated region..........cccccveveeiieiieeie s 20
DO B T o] F= Y] - U ] [P 21
XE.WOork with @ BatCh File ... 22
XIT. OVEIVIBW ...ttt bbbttt bbbt bbbt 23
WAL WE TTKE ... et nb e nre s 23
WHhat W dISHKE. ..o 24
QUICK STANT 1N 10 STEPS....otieieeiiieitieie ettt sttt sb e b sne e 25
1. TOStart WINMDI 2.8ttt e 25

2. To display a 2-parameter NISTOQram .......ccccccveivereiiieie e 25

3. TOCreate @ 3D PIOt.......ooieeiiie e 25

4. TO rotate @ 3D GraPh ..cc.eceecieieeie et re e e 26

5. To display a new single-parameter NiStOgram ...........cccooerieninienieenesie e 26

T ol (T (I W =0 | o] SO SP 26

7. TO CIEALE ALES ...eeeiiiee ittt ettt nb b e e snb e e ne e s nn e e 27

8. TO diSPlay StALISTICS. .. ..veieeiieiesie e esie e e e neesreenneens 27

9. To create histogram OVEIIAY..........ccoiiiiiiiiieiie e e 28
10. To create 3D View OF NIStOGramsS.........ccceiverieiiiiieie e 28




Version 2.1 June 2004

I. How to Install WinMDI 2.8

The Windows Multiple Document Interface software (WinMDI) is freeware
designed by J. Trotter (1993-1998; trotter@scripps.edu) to analyze flow cytometric
listmode data  files. You can download it from the URL

http://facs.scripps.edu/software.html or find it on any of the Purdue CD-Roms. To install

WinMDI 2.8 on your computer, just click on the web page link corresponding to your
office system (Windows 95/98/NT or Windows3.1/NT 3.x) and open (or save on your
computer and install later) the corresponding wm28w95.exe or winmdi28.exe programs.
Follow then the instructions.

The minimum system requirements are:

Processor: 486/33 + 387 fpu math chip or better with 8 megabytes memory.
Recommended: 486/66 with 16MB RAM or better

Monitor: SVGA 800x600 or 1024x768 recommended.

OS: MS DOS 5.0 or later + MS Windows 3.1 or later, Windows NT,
Windows XP, or OS/2

e Windows 3.1: Use Microsoft's SMARTDrive or other disk cache program.

Hint!

| SUGGEST THAT YOU USE LISTMODE DATA FILES WITH 8.3 FORMAT FILE NAMES.

I1. How to Start WinMDI 2.8

To start WinMDI just click on the WinMDI icon on the desktop, or use Start >
Programs = WinMDI = WinMDI.exe. The following screen is displayed.
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With WinMDI 2.8 it is possible to create single-parameter histograms, dual-

parameters histograms (also called cytograms), and even 3D histograms. The WinMDI

Display dialog window offers 4 different graph styles (see figures below):
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Histogram: displays one or more parameters as a frequency distribution (256
or 1024 channels).

Dotplot: displays correlated data from any two parameters at a 256x256
resolution. Each dot corresponds to an event analyzed by the flow cytometer.
Of course, several events can occupy the same dot if they have the same
parameter intensities.

Density plot: displays two parameters as a frequency distribution. Color is
used to code the different frequencies of events.

Contour plot: like a dotplot, a contour plot displays correlated data from any
two parameters, with contour lines joining points of equal elevation

(frequency distribution).
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I11. How to Create a Single-parameter Histogram

From the WinMDI Display dialog window select the “Histogram” style and click
the OK button. A new window allows you to navigate to the sample folder where the

listmode data file to analyze is recorded.

When the file is selected, press OK. The Select Parameters dialog window appears

for selection of the parameter to display.

Select Parameters |
Filename: KRO052049 LD

Parameters: 5

ID: sample9terFC5
Date: 28-May-03
8738 Events
Cytometer: XL Y05041

Select Show All or a Single Parameter

-

55 1024 S0LS
FL1 LOG 1024 green flua
FLZ LD 1024 arange fluo bl

Read I Cancel | Owerlay |

Using the scrolling bar, select the parameter you want to display (FS: forward-angle
light scatter; SS: right-angle light scatter; FI1, FI2, ..., Fln: the first, second, and n"
fluorescence recorded by the cytometer). Click the “Read” button to display the

corresponding histogram.
All the parameters are automatically recorded within each listmode data file. You

do not need to type them in the software.
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Hint!

SOMETIMES WINMDI DOES NOT AUTOMATICALLY RECOGNIZE WHICH AMPLIFICATION
IS USED (LINEAR OR LOGARITHMIC). YOU NEED TO SPECIFY THE SCALE BY SELECTING
TooLs = SET LINLOG TO OPEN THE LIN/LOG VARIABLES DIALOG WINDOW. THEN CHECK

THE CORRESPONDING SCALE FOR EACH PARAMETER.

Very often it is necessary to change the position of the histogram and optimize the
size by stretching its different borders and/or corners.

In the Select Parameters dialog window scroll bar, the “Show All Parameters”
option generates a single graph in which all the histograms of all the different parameters
are plotted together. If you click on the graph and select “Format” in the popup menu the

Format Histogram dialog window is displayed (see below).

X

File: GFP_EC~2.LMD &I

Events Axis

Log ¥ / Lin Y Events [
Normalize to Events [~
Calculate Default Y [~

(- Histogram Cantral
Name X Awi Scalo
1-FsPeak || [inear | Cancel

Title: Line Width

FS Peak

¥ Solid Fill How Filo
v

SO | —
FB+w

[ Show Text Choose Color

[¥ Dpague Text

" 3D View  Smooth: Help

1

Cnvt to 256

Among the available options you can, for instance:

e Set the color of each histogram. Just select the corresponding histogram
name and select the color (scroll menu). You can fill the histograms with
their respective color (check the “Solid Fill” check box) or leave them
empty (uncheck the box).

e Rescale the histograms by changing the “Y Scale” value.

e Change the thickness of the lines (change the “Line Width” option);

e Display all the histograms in black & white (check the “B+W” check box).

e Display all the histogram in 3 dimensions (check the “3D View” check box).

e Smooth the histograms.

e Set up a logarithmic scale for the vertical axis.

e Insert a title (see the “Title” scroll menu).
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V. How to Create Histogram Overlay

You can create a histogram overlay using WinMDI 2.8 (see figure below).

128

Events

1b" n ""'Hb‘ 107 ' ""'Hbz T ""'HD‘
logFluo-3

To create the overlay:

1.  Create a single-parameter histogram from a listmode data file: open the
data file by clicking File> Open File, then navigate to the file and press OK.
Click on the “Histogram” style, and select a parameter. Click on the “Read”
button to display the graph.

2. In the same way, open a new data file, click on the “Histogram” style,
select the same parameter as previously, but click on the “Overlay” button to

create the overlay (not the “Read” button). The histogram will be plotted on top of

the previous one.

You can overlay up to 12 histogram parameters on the same graph. You can also
change the color of the different histograms using the Format Overlay dialogue window
(click on the graph and select “Format” in the popup menu. The “Histogram Control” box
is for making changes to the original, or first histogram. The “Overlays” box is for

making changes to the histograms overlaid on top of the original histogram.
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V. How to Create a Dual-parameter Histogram

If you decide to plot first a dual-parameter histogram, you need to choose which
style of plot you want to draw from the three different styles displayed in the WinMDI

Display dialog window: a dotplot, a density plot, or a contour plot.
1. How to create a dotplot
Select the “Dotplot” option in the WinMDI Display window and click the OK

button. In the Open Dotplot window navigate in the folders and select the listmode data

file you want to analyze. Press the OK button. The following window appears on the

=
} File: CEELE —Plot Humber of Events ——
e ThE : (¥ 2000 only

Parameters for X and Y " Half [4369)
374 [6553)
" All (8738)

T ‘SS 1024 A0S j‘ " Set:

~Draw Options
[ Kinetics Mode
S5 3 decade log [~ |Dwerlay Kinetics Line
4 decads log [~ | Draw Kinetics Only
Dk I Cancel | Gates ¥ Show XY Lahfals
[ Color 2D Regions
MewFile | 3D Plot | | Help | | ¥ LogGrid 3D

Parameter Amplifier/Scale

Different options are displayed in order to create the dotplot.

e The name of the listmode data file is automatically displayed at the top of the

window.

e Just below the filename, the user can select which parameter to display on the
x axis and which one on the y axis. When selected, these two parameters
appear in the “Parameter” box. To the right of this box, the “Amplifier/Scale”
box display different possible scales for the axes. Select the first parameter
(ex: FS on the previous figure) and then select the corresponding scale. Select
“Linear” if this parameter has been recorded in linear mode. If this parameter
has been recorded in logarithmic scale, then select the number of decades
corresponding to the flow cytometer protocol setup (3 or 4 decades). Repeat

all these steps for the second parameter.
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In the “Plot Number of Events” area, different options are available in order to
display 2000 events only, or half, three quarters or all the events recorded.

You can also set a specific number of events (type the value).

In the “Draw Option” area are 6 check boxes. The first three are related to
kinetics analyses where the intensity of one or several parameters is monitored

with the time.

The “Show XY Labels” check box needs to be checked in order to label the

axes.

The “Color 2D Regions” check box needs to be checked to color the events
gated on a histogram. Gating and coloring events can be used simultaneously
in order to localize on one or several histograms the events gated in another

histogram. For more detail see VII. Regions and Gates.

The “Log Grid 3D” check box is dedicated to histograms displaying three
parameters at the same time. If this box is checked, a grid is applied on the
different axes to underline the logarithmic scale. Of course this grid concerns

only parameters acquired in the logarithmic scale.

Six buttons are also available on the “Format Dotplot” window.

Click the “OK” button to close the window when all the desired options have been

selected.

The “Cancel” button closes the “Format Dotplot” window without taking into

account the selected options.

The “Gates” button opens the Gate List dialog box in order to handle regions or

gates (see VII. Regions and Gates).

The “New File” button allows you to change the listmode data file to work with.

The “3D Plot” is used to convert the current dual-parameter histogram into a 3-

dimensional histogram. When this button is clicked the Select xyz dialog window

appears. You can choose the three parameters to display. To select a parameter either

double-click on it or select it and press the “>>" button. When a parameter is selected it is
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listed in the right X, Y, and Z Parameters box. To remove or change one or all the

parameters click the “Reset” button. When the three parameters are selected press the
“OK button.”

The “Abort” button aborts the 3D transformation.

The “Help” button opens the WinMDI 2.8 help.

2. How to create a Density plot or a Contour Plot

These graphs are very useful to identify the borders between several close clusters.
In the WinMDI Display dialog windows select the “Density Plot” or “Contour Plot”
option and click the OK button.

In the new Open Dotplot dialog window, navigate in the folders and select the
listmode data file you want to analyze. Press the OK button.

Whatever option is selected, the Format 2D Display dialog window appears on the
screen. In fact it is not exactly the same window. Indeed, there is one difference: the
“Density Plot” check box is checked only in the case of a density plot (see figure below).

Later on, it is possible to shift from the density plot to the contour plot just by checking
this box or not.

Contour Plot: Density Plot:

Format 2D Display

= x
’ ~Contour/DensityPlot ~Contours " our/DensityPlot - Contour
File: KROB1879 LMD - - File: KROG1 979 LMD = =
Density Plat ¥ Colar v Dgnsity Plot [ Color
X and Y Parameters ¥ Map >= mg ¥ and Y Parameters ’ Hap »= m:
Bl 024 5 Smooth: [0 [F] || & Rew deta Smooth: + Rew deta
=]  Smoothed data =] £ Smoothed data
v. [FU1 o5 102 gremn e =] Threshold v Wt (Wl
Parameter  Amp/Scale Display Colors (EL IALEE i Parameter  Amp/Scale Display Colors Drawing Algarithm
= s =] [~ Thick I Thick
FL1 LOG Gdecadelon = ¥+ Logatithmic FL1LOG 3 decade log '| % Logarithmic
Display Array Resolution ¥ Label Axes 1 Lingar Display Array Resolution [ Label Axes ¢~ Linear
196 x 128 (65 5KB) = I¥ Calculate Calors  18L28) ||~ popopip, 128 x 128 (65.5K8) =] [ Calculate Colors  18L#] ||/~ ooy,
ic 30 Size Density — LR an Size Density — SRR
i Ratation: |50 i Rotation: |-
STt T Wiy € window || Ierval () [50.00 I Show 3D Display aration  Window || Interval2) [E000 |
I~ Use Region Colors Tilk: " Use Region Colors Tilt:
= & Element flext=Uast x " Element Hext=Last x
Set 3D Fill Color Distance: Set 3D/ Fill Color Distance:
ok | Cancel | Gates | New Fils Help | ok | Cancel | Gates | New File Help |




Version 2.1 June 2004

The Format 2D Display dialog window displays several pieces of information on
the graph.

e The name of the listmode data file is automatically displayed in the top
left corner.

e You can choose which parameters to display (X and Y parameters), the
type of amplification (linear, or logarithmic), and the resolution.

e Check the “Density Plot” check box to draw a density plot histogram.

e Check “Label Axes” in order to label the two axes.

e The “Color” check box is used to display the different densities of events
according to a color code set up automatically (check the “Calculate Colors”
check box) or by the user (uncheck the “Calculate Colors” check box and

choose a color through the “Display Colors” menu).

Hint!

| SUGGEST THAT YOU LET THE SOFTWARE HANDLE THE COLOR CALCULATION AND THE
DIFFERENT OPTIONS DISPLAYED ON THE RIGHT OF THE WINDOW (CONTOUR). LATER ON, IT
IS ALWAYS POSSIBLE TO CALL UP THIS WINDOW AND CHANGE SOME OPTIONS IN ORDER TO
SMOOTH THE DENSITY OR THE CONTOUR LINES, TO SET UP A THRESHOLD, TO CHANGE THE
THICKNESS OF THE LINES, TO SELECT ANOTHER ALGORITHM TO SET UP THE CONTOUR OR

DENSITY PLOT, ETC.

Hint!

IT IS ALSO POSSIBLE TO CREATE A 3D HISTOGRAM BY CHECKING THE “SHow 3D
DISPLAY” CHECK BOX. THE DENSITY OF EVENTS WILL BE PLOTTED ON THE THIRD AXIS. IT IS
THEN POSSIBLE TO COLOR ON THIS 3D HISTOGRAM THE EVENTS WHICH WOULD HAVE BEEN
GATED ON THE 2D HISTOGRAM BY CHECKING THE “USE REGION COLORS” CHECK BOX. IT IS
POSSIBLE TO CHOOSE THE COLOR USING THE “SET 3D FiLL COLOR” MENU. IT IS ALSO
POSSIBLE TO CHANGE THE ORIENTATION OF THE 3D DISPLAY BY CHANGING THE

“ROTATION” ANGLE AND/OR THE “TILT” AND “DISTANCE” VALUES.
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Five buttons are also available on the Format 2D Display dialog window.

Format 2D Display x|
_ i~ Contour/DensityPlot - Contour.
File: KROS1979 LMD

" Density Plot [ Color

X and Y Parameters

Smooth: [0 & || & Raw data

Threshold £ Smoothed data

¥: [FL1LOG 1024 green fluo d

Parameter Amp/Scale Display Colors Drawing Algorithm

I Thick
e Tre— e & Logortns
Display Array Resolution [ Label Axes " Linear
128 % 128 (85.5KB) = [¥ Calculate Colors 18181 ||~ by

- o Size Density— " Old algorithm
A Rotation: |30
:zﬁhnw 3D Display C whindow || iterval (%)
Wse Hegion Colors Tilt: 25
: % Element Mest=l =t
SetaD FllColor | pistance:

Cancel | Gates | New File | Help

- Click the “OK” button to close this window and display the graph when all the
desired options have been selected.

- Click the “Cancel” button to close the dialog window without taking into account
the last changes.

- The “Gates” button opens the “Gate List” dialog box and defines the regions or
gates (see VII. Regions and Gates).

- Click the “New File” button to select another listmode data file.
- The “Help” button opens the WinMDI help file.

3. How to create a 3-dimensional display

It is possible to transform any histogram, dot plot, density plot, or contour plot into
a 3D graph displaying three different parameters. A left click anywhere on the graph
shows a new menu. A left click on the “Format” option opens the Histogram Format,
Dot Plot Format, or Format 2D Display dialog window respectively for a histogram, a
dot plot, or a density (or contour) plot. To display the 3D graph just check the “3D view”
or “Show 3D Display” check box and press OK, or press the “3D Plot” button. These
steps are reversible and it is thus possible to come back to a 2D graph.

10
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It is possible to change the orientation of the 3D graph using the mouse. Just press
the Ctrl key on your keyboard and at the same time click the mouse on the graph. The

graph changes and displays then only an empty cube without any labeling (see below).

B Dotplot - mixblue {1,3,4) 5001 - B# Dotplot - mixblue (1,3,4) 500 =131 x|

—

Just keep clicking the Ctrl key and the left mouse button and drag the mouse to
change the orientation of the graph. When the desired orientation is reached, release the

mouse button to display the graph.

4. How to change the parameter labels and font

WinMDI automatically labels the axes of the graphs. The default labels are those
recorded in the listmode data file. To set new label(s), select in the tool bar Tool -
Parameter Labels (or press Alt+L) to open a dialog window. Type the new label(s),
check the “Use these instead of file labels” check box, and press the OK button.

To change the font press F8 or select in the tool bar Window > Set Defaults >
Font. Select the font, the style, the size, the effects, and the color. Click the OK button.

5. How to display a title or write annotations on a graph

You can write a title on each graph and add comments. Select in the tool bar Tools
- Annotate (or press Alt+A) to open the Annotation dialog window. Type the text or
the title in the “Text” box. Choose the font, size, and style and press the OK button. Then
move the mouse cursor and click with the left mouse button where you want to display
the text.

11
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You can move, modify or delete the annotation at any time.

- To move the text: just click on it and drag it.

- To modify the text: keeping the “shift” key pressed, double click on the

annotation then type the new text and press “Enter”.

- To delete an annotation or a title: keeping the “shift” key pressed, double

click on the annotation to select it and press the “Delete” key.

V1. Zoom

It is possible to magnify a particular area on any plot:
- Click with the right-button of the mouse on the plot of your choice and move

the mouse in order to define the area to zoom in.

¥ Dotplot - Fuglenalog (1,2) 2000 B=E

=t
o
-
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FL2 Log
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101

10° 102 10° 10*
FL1 Log
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- Click with the left button of the mouse within the defined area. In the pop up

menu click on Zoom.

% Dotplot - Euglenalog (1,2) 2000 HEE

To unzoom, click with the left button of the mouse anywhere in the plot and in the
pop up menu select Unzoom.

Zooming and unzoming can be performed several times on the same plot.

VII. How to Create and Display Several Graphs on the
Screen

To create a new graph once the first graph has been displayed, select in the tool bar
the “Display” button and choose which type of graph you want to draw. Then repeat the
previous steps to select the listmode data file to open and to define the settings of the
graph.

When all the graphs are displayed, it is possible to resize them, to move them one
by one, or to reorganize them automatically using the Windows button in the tool bar.

The Windows ->» Cascade option superimposes the different graphs on top of each
other and only the first one is visible. The Windows > Tile option shares the screen

between the different graphs which are thus all visible.

13
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Several other options also allow the user to Minimize All, Restore All, and Close
All graphs.

Hint!
TO CREATE A NEW GRAPH WHEN ALL THE PREVIOUS GRAPHS ARE CLOSED, CLICK FILE
- OPEN FILE, CHOOSE THE TYPE OF GRAPH TO DISPLAY, AND THEN NAVIGATE TO THE FILE

TO OPEN.

VIII. Regions and Gates

Now that you’ve learned how to open a listmode data file and display the main
graphs, you need to learn how to create regions and gates. A region can be defined as set

of points carefully selected by the user that determine an area on a graph.

One or several regions can be defined on the same graph (see Figure below).

A0LE (3 vs FE(2)

1023

a 1023

The regions have to be distinguished from the gates. Gates are Boolean expressions
containing one or several regions. So a gate can be equal to a region, but this is not

always the case.

14
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The regions are used to compute statistics for the subset of events selected by the
user in a peculiar histogram. Moreover, this cluster can then be gated and its events
colored on the other graphs.

WinMDI offers 4 different region styles. The “Histogram” region can be drawn
only on a one-parameter histogram plot. The three other styles (“Polygon,” “SortRect,”
and “Ellipse”) can be applied to any two-parameter graph.

No region can be directly drawn on 3D graphs.

1. Create a region on a 1-parameter histogram

To create a “Histogram” region click the left mouse button on the histogram graph
where you want to draw the region. A popup menu will appear. Select “Regions” to open
the 2D Regions Tool dialog window. Sixteen regions from R1 to R16 (R means region)
are then listed with different colors. The events contained in a region will be colored. To
change the color, click on the color and select another one. Select the “Histogram” region
style (it should already be selected). Click the “Create” button. The Set Region Tool
dialog window appears. On the histogram click with the left mouse button where you
want to set up the lower (left) limit of your region. Then click with the right mouse button
where you want to set up the upper (right) limit of the region. You have just created a
marker (labeled from M1 to M8).

The lower and upper limits are displayed on the Set Region Tool dialog window.
To transform a marker into a region (labeled R + a number) just press the “Create Region
from Current Marker” button. To erase the marker just double-click with the right mouse

button on it.
1=k

o
]
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You can create other regions on the same histogram by creating a second marker.
Just change the marker index and create a new marker on the histogram. Create a second
region from this second marker. You can create up to 8 different markers or regions on

the same histogram.

Hint!

YOU CAN ALSO GENERATE MARKERS WITHOUT GENERATING A REGION TO GET
STATISTICS, BUT IN THAT CASE THE EVENTS CANNOT BE GATED ON THE OTHER GRAPHS. To
CREATE A MARKER JUST CLICK THE LEFT MOUSE BUTTON ON THE HISTOGRAM AND SELECT

“MARKERS” IN THE POPUP MENU. THEN PLACE THE LOWER AND UPPER LIMITS OF THE
MARKER AS PREVIOUSLY DESCRIBED.

2. Create a region on a 2-parameter histogram
On a 2-parameter histogram you can draw three different region styles. Click the
left mouse button on the graph where you want to draw the region. A popup menu
appears. Select “Regions” to open the 2D Regions Tool dialog window. Select the region

style: Polygon, SortRect, or Ellipse (see figure below).

Polygon Style SortRect and Ellipse Style
=R IR TF
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Polygon Style

The polygon style allows you to draw a polygonal region. Click on the graph where
you want to start your region. You just defined the first point in the region. If you release
the mouse button and move the mouse to a different position you will see a segment
connecting the first point to your mouse pointer. Click to set up the second point in the
region. Continue to move the mouse and click when you want to define a new point in the

region. To close the region, you need to click on the first point.

SortRect and Ellipse Styles

The SortRect style allows you to draw a rectangular (or square) region. Click on the
graph where you want to set the upper left corner of the region. Then keep the left mouse
button pressed and move the mouse to draw the region. The region appears as a dashed
line. When the region is correctly drawn, release the mouse button.

The ellipse style allows you to draw an elliptical (or circular) region. To draw such

a region just processed as for the rectangular region.

3. How to create a quadrant

A quadrant can be used only in bivariate displays. Quadrant divides a graph into 4
regions: upper left (labeled UL), upper right (UR), lower left (LL) and lower right (LR).

@ Dotplot - 00000141 (6,2) 389 =10l x]

o

102

lick here to select and
] move the quadrant

102

FL2 Log

101

100

g 053
FS Lin

To create a quadrant, click on a graph and select “Quadrant” in the popup menu.

The 4 regions are displayed. To adjust the size and the localization of the regions you

17



Version 2.1 June 2004

need to activate the quadrant and then click where you want to display its center. To
select the quadrant, you can double-click the center of the quadrant or press Alt+Q or
click the “Tools” button in the main tool bar and select “Quadrant Tool.”

The quadrant position is used by WinMDI to calculate statistics within each of the
four regions. The statistics can be displayed in the “Stats” window.

The percentage of events gated in each region is also displayed in each corner of the

graph.

4. How to delete, move, or adjust a region

To delete a region

To delete a region, click on any graph with the left mouse button. In the popup
menu select “Regions” to open the 2D Regions Tool dialog window. Select the region to
delete (check its check box) and press the “Delete” option button. Close the dialog

window. You can delete only one region at a time.

Hint!
SOMETIMES THE DELETED REGION IS STILL DISPLAYED ON THE GRAPH. TO CORRECT

THIS ARTIFACT CLICK ON THE TOOL BAR WINDOW =» REFRESH ALL (OR PRESS ALT+END).

To change the localization of a region or resize a region

For a 1-parameter histogram it is easier to delete the region and to draw a new one
in the right localization.

For any 2-parameter graph (dot plot, density plot, or contour plot) the way regions
are resized or moved is common to all region styles. To move a region, double-click on
the region to select it and drag it to its new location. You can also move the label without
moving the region. Just double click in the region to activate it, click on the label and
drag it where you want. When done, release the mouse button.

To resize a region, double click on the region to display the size handles. Click on

the handles and drag them to adjust the size of the region.
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5. Create gates

“Gates” are Boolean expressions containing one or several regions. They are
defined using the different logical operators AND, OR, and NOT to combine the different
regions. But gates are not manually drawn like regions.

To define a gate on a graph, click on the graph and in the popup menu select

“Gates” to open the Logical Gate Tool dialog window (see figure below).

Logpcal Gabe Toal _J
Diotplol - 13m1_Fes [1.2) 13236

Lugical Gates

Region
{pi-5,2 |Polygom)
{RE=%.% {(Polygoni
|P3=-E5,3 |Pelygan)

= MultiColor R - A3
Gate All Windows | Dwnes | Help |

ok | [ Deee | Cancel |

The Logical Gate Tool dialog box consists of two lists. On the left part is the list of
all the existing regions (R1, R2, etc.). On the right is the list of the logical operators.

To create a gate on the graph, you need to assign each necessary region with its
correct logical operator.

When you select only one region, for instance R1, and the logical operator AND,
this means that all the events of the region R1 will be gated on the graph and displayed.
But if you also select the Region R2, and select also the AND operator for this region,
then only the events which are in both R1 and R2 will be gated and displayed.

If we take the same example with the operator OR, then the events which are in R1
only, or in R2 only, or in both R1 and R2 will be gated and displayed.

The operator NOT must be used to gate the events of a region that you do not want
to display. This is particularly useful when you want to get the statistical results of a
cluster of events mixed with another cluster on the same graph (let’s say forward scatter
vs side scatter). You can create a region around the “not desirable events” on another

graph where your clusters are well separated (for instance fluorescence collected on
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PMT1 vs Side Scatter) and thus gate them out of the forward scatter vs right scatter
graph.
All regions not necessary to define your gate need to have the OFF logical operator

selected.

IX. Convert a FCS file to a text file

1. Convert a data file

With WinMDI you can convert a FCS file into a text format. The data can thus be
read by another software for further analysis beyond that of the regular flow cytometry
software.

To convert an entire FCS data file, click on File > Save As, then :

- Select Tabbed Text from the file type list box,
- Under File Name type in the new file name,
- Click on Save.

Hint!
Under Preferences you can choose if the text must correspond to the
channel value (if you work in linear scale) or to the arithmetic value (for log

parameters).

2. Only convert the data from a gated region

Draw the region(s) you need to perform your gating and display only the cells of
interest. The shape of the region(s) does not matter for converting the data. Click on File
- Save As, then :

- Select Tabbed Text from the file type list box,
- Under File Name type in the new file name,

- Click on Save.
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X. Display Statistics

You can display the statistics for any and all regions in WinMDI in the Stats
window. To create the Stats window, click on a graph and select the “Stats” option. This
window already contains certain information (file name, date, etc.) and some statistics. In
the tool bar of this window click the “Format” button in order to open the Edit Statistics
dialog window. This new window lists the different information that can be displayed in
the Stats window. To select a field just check the corresponding check box, to unselect
one just uncheck the check box.

The different statistics you can display for each region are:

File name

Sample ID/Title
Date

Cytometer

% Total events

% Gated events
Markers

Events

Mean/CV
Geometric log means
Median

Peak channel value
Parameters

Range

Use Tabbed Format

When the statistics are displayed you can use the tool bar buttons of the Stats
window to perform different operations:

= You can update the statistics (press the “Update” button) each time you move,
remove, or create a region on a graph;

= You can save the statistics in a text format (.txt) in a new file, in order to read
them with different software (press the “SaveAs” button). This new file can be
named as you want: just type a new name instead of the default “statfile.txt”
name.

= You can also print the statistics (press the “Print” button).

= The “Owner” button is used to show you on which graph you clicked to create
the “Stats” window.
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Hint!

YOU CAN ADD OR REMOVE SOME TEXT DIRECTLY IN THE “STATS” WINDOW. JUST
CLICK INTO THE WINDOW WHERE YOU WANT MAKE THE MODIFICATION AND DELETE OR
TYPE THE TEXT.

YOU CAN ALSO DIRECTLY DISPLAY THE STATISTICS FOR EACH 1-PARAMETER

HISTOGRAM BY SELECTING DISPLAY - SCREEN STATS.

XI1. Work with a Batch File

You can generate a working list of data files in order to aid in the automation of
their analysis. You create each graph only once and then you can navigate between the
listmode data files you want to analyze and/or compare = You save time.

To create a list click on File = List ... or press Ctrl +1, then select the listmode
data files. To select the different files you need to press the Ctrl key + click the left
mouse button on the different files. When the list is defined, you can work up and down
the list using the File > Next File and Prev File.

Click *“OK” to retain the list; “Cancel” to delete it; and “Reset” to create a new list.

The “Close” button closes the list.

Hint!

YOU NEED TO UPDATE EACH GRAPH WITH THE FILE YOU WANT TO WORK. YOU CAN
USE THE NEXT OR PREVIOUS FILE BUTTONS. BUT YOU CAN ALSO CLICK ON A GRAPH, THEN
SELECT THE FILE IN THE “FILE LIST DIALOG” DIALOG WINDOW AND PRESS THE OK BUTTON

OF THE DIALOG WINDOW. REPEAT THESE STEPS FOR EACH GRAPH.

Hint!

IF THE FILES ARE IN THE SAME DIRECTORY AND LABELED WITH INCREMENTED NAMES
(1 0628P101, 0628P102, 0628P103 oR 06PIA, 06PIB; ETC.) YOU CAN DIRECTLY LOAD THE
NEXT FILE BY SELECTING FILE = NEXT FILE, OR WORK ON THE PREVIOUS FILE BY
CLICKING ON THE PREVIOUS FILE OPTION. NOTE THAT THE FILE NAMES IN THE DIRECTORY

MUST CONSTITUTE A CONTINUOUS SUITE OF NUMBERS OR LETTERS.
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XI1I. Overview

| What we like...

WinMDI version 2.8 is able to read FCS 1.0 and FCS 2.0 data files, that is

to say the major part of listmode data files from current flow cytometers.

You can create and display multiple graphs simultaneously on the screen.
You can choose among 5 standard types: histogram, dot plot, density plot,
contour plot, or isometric. The 3D graphs are very nice and you can rotate or
tilt them.

You can copy and paste the graphs into other software (useful for

publication).
You can overlay several histograms.

You can gate events in color regions using the mouse, use quadrants, and get
statistics. A complex gating can be done using logical operators (AND, OR,
and NOT).

Dual-parameter histograms can display a grid. Very useful to underline the

intensity shifts in any parameters.
Time can be used as a region/gating parameter if it is a recorded parameter.

The medians and means for log-acquired data are converted to a linear

intensity scale.

Once a graph has been created, it is possible to use the drag & drop
capability to read a new data file. Just select the new FCS data file within

your file manager, drag the icon to WinMDI, and drop it in the selected
graph.

The most commonly used functions are directly available from a pop-up

menu.
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What we dislike...

No tutorial is provided with the software.

The quadrant analysis is supported but the results cannot be shown on the dot plot

itself.

Kinetics are difficult to perform (the median Y line cannot be drawn vs. time; the
event number cannot be used as a dot-plot X parameter if time is not a recorded
parameter; the medians cannot be obtained for a user-specified number of slices

of each listmode file).

The cell cycle analysis on DNA fluorescence histograms is not supported (no

model or algorithm available).
The histogram vertical scaling is adjustable only in factors of two.

You may need to perform “Refresh” of the different graphs in order to remove

display bugs on the screen.
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Quick Start in 10 steps

1. To start WinMDI 2.8

Open WinMDI by clicking on the WinMDI2.8 icon on the desktop

A WinMDI display box will appear with histogram highlighted, just select OK
Select data file from appropriate directory > OK

Select Show all parameters > READ

Left click on the window

Select format

Change Y scale to rescale histogram

2. To display a 2-parameter histogram

Click on Display at the top > Select Dot Plot, or Density plot, or Contour plot
Select file or OK

Select X-axis

Select Y-axis

Select the number of events you want to display. In “plot number of events”
section select from the choices how many events you want to show. (It defaults
to 2,000 events.) You may also type in a specific number of events by choosing
SET.

OK

3. To create a 3D plot

Display dot plot, plotting 2 of the parameters
Left click on histogram

Select format

Select 3D plot

Click on first parameter > Select parameter
Click on second parameter > Select parameter
Click on third parameter > Select parameter
OK
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4. To rotate a 3D graph
1. Leftclick on histogram
2. Select rotate
3. Use the Ctrl key and the left button of the mouse over the display to change the
orientation.
4. Close

5. To display a new single-parameter histogram
1. Select Display > Histogram
2. Select file > OK
3. Select the parameter you wish to display
4. Click on READ

6. To create a region...
...on a 1-parameter histogram

1. Create the histogram display you want
2. Click on the histogram window
3. Select Markers
4. Create the marker/markers you want to use as regions
5. Close the markers dialog box
6. Right click on the histogram again
7. Select Regions : the first to create will be R1
8. Click on the Create button to get the Markers -> Region tool

- use the top half to select the marker you want to become a region

-then click the create Region from current marker button to copy the marker

into a new region. Do this for each histogram marker you want to be a region

9. Close the tool dialog box by clicking OK.

...0n a 2-parameter histogram
1. Left click in the 2-parameter histogram in which you wish to create a region

2. Select Regions
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3.

4.

Select the region style
a. polygon
b. sortrect
c. ellipse

Click on Create

5. Draw region on the graph

6. Click OK to close the dialog window

A w0 Dp R

7. To create gates

Left click on the histogram to which you wish to apply this region

Select Gates

Select the region you want to use

Set a region logic operator (AND, OR, and NOT) for each region to combine

Loagic operator | Effect
Off none
And event must always be within this region
Or event can be within this region
Not event cannot be within this region

8. To display statistics...

...on a 1-parameter histogram:

1. Click on Display

2. Check screen stats

...in the STATS window:

1. Left click on histogram

2. Select stats
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9. To create histogram overlay

1. Open first histogram:

- File > Open
- Read

2. Open second histogram and click on Overlay instead of Read

NOTE: the read single box must be checked to give the overlay option

3.

Continue to add histograms you want on the overlay.

NOTE: Open and overlay all histograms before doing any formatting at all.

4.
S.

Left click on the overlay histogram

Select format (do whatever formatting you want) :
a. Rescale

b. Take off solid fill, etc.

NOTE: The Histogram Control box is for making changes to the original or first

histogram. The Overlays box is for making changes to the histograms overlayed on

top of the original histogram

10. To create 3D view of histograms

o > N E

Make overlay
Left click on histogram
Select Format
Select 3D view
To rotate:
a.) click on histogram
b.) select Rotate
c.) use ctrl key and left mouse button over the display to change
the orientation

Close
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